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What Is WPC

WPC (Web Page Creator) is a utility that helps in the creation of pages for the World Wide Web. 
WPC will not ask you questions and then create a generic page that is completely void of any type of 
personality.    However if you want to create a really eye-catching page that truly reflects your creativity 
then WPC may be just what you have been looking for.

One important fact that should be gotten out of the way early is that WPC is a work in progress.    
This software has been developed completely from users comments and suggestions and will continue to 
be updated from future suggestions.    This is not the first version and will surely not be the last.    If you 
have any suggestions that you feel will help to improve WPC, feel free to Email them to me.    Actually I 
would be interested in hearing your comments whether negative or positive. 

Please note that many of the HTML tags that are inserted into a document will only be visible to web 
browsers that are using NetScape 2.?? and above.    If you are not using a current version of NetScape 
then I suggest you get it now.    It is well worth the download.



Address Email to sparker@tricon.net



Registered Version of WPC

There are no longer Registered and Shareware versions of WPC.    They are now one and the 
same.    However if have not registered WPC many of the commands will not be available.

Remember you can download the latest registered version of WPC at 
www.geocities.com/Broadway/1172.    The registered version will only work if you have a registration 
number.

If you have any questions, comments or just want to get in touch you can send me Email.



WPC Menus

File View
Edit Window

HTML Options
Frame About

Browser Help



File Menu

New Project
Creates a new project and opens an initial edit window.    Only one project can be open at a time.

Open Project
Opens a previously saved file along with all the files associated with it.

Save Project
Saves the current project along with it’s files.

Save Project As
Allows you to save the current project using a different file name.

Close Project
Closes the current project and all of it’s associated files.

New File
Creates a new document window.    You will be asked if you want to insert the default template.    If you 
answer yes the HTML, Head and Body tags will automatically be added to the new document.

Open File
Opens an existing document in a new window.    WPC keeps track of the documents you last worked on. 
You can quickly open one of them by selecting it from the bottom of the Window menu.

Save File
Saves the active document.    If the file has not been previously saved you will be prompted for a filename 
and the path where the file is to be saved.

Save File As
Displays the Save As dialog box where you specify a filename and the path where the file is to be saved. 
You will be prompted for this information even if the document has been previously saved.

Import
Imports a text file into an HTML document and performs predetermined conversions.

Close File
Closes the active document.    If the document has been modified since it was last saved, you will be 
prompted as to whether you want to save it before closing.

Print File
Sends the active document to a printer.

Printer Setup
Displays the Printer Setup dialog box where you can specify new printer settings before printing a 
document.

View GIF
Allows you to view a GIF graphics image.    WPC supports Interlaced and non-interlaced GIF files.



Exit
Closes all open documents and exits WPC.    If any documents have been modified since they were last 
saved, you will be prompted as to whether you want to save them before they are closed.



Edit Menu

Cut
Removes selected text from the current document and copies it to the Clipboard.    The text on the 
Clipboard remains there until you replace it with new text.

Copy
Copies selected text to the Clipboard.    The text on the Clipboard remains there until you replace it with 
new text.

Paste
Inserts a copy of the text in the Clipboard at the cursor position in the current document.    If text is 
selected it is replaced by the contents of the Clipboard.    If the Clipboard is empty no text will be inserted 
but selected text will be deleted.

Delete
Removes selected text from the current document.    The text is not copied to the clipboard and can’t be 
pasted back into the document.

Search
Searches for specified text from the cursor position to the end of the document.    Search can also be 
activated by pressing F2.

Search Next
Searches from the cursor to the end of the document for the next occurrence of the text specified in 
Search.    Search Next can also be invoked by pressing F3.

Replace
Searches for and replaces specified text from the cursor to the end of the document.    Clicking on OK will 
only replace the first occurrence of the text while All will replace every occurrence in the document.    
Replace can also be invoked by pressing F4.

UNDO
Reverses the last edit command.    Reinserts deleted text and removes inserted text.

REDO
Reverses the last UNDO command.



HTML

Background Tables
Image Text Format
URL Symbols

Anchors Forms
Header Fonts

Lists Base
Format



Background

Background

Color
The color checkbox allows specification of the color that will be used for the background of the HTML 
page.    Once you have placed an X in the checkbox you can click on browse and select the color from the 
dialog box.    The new color will be shown in the edit box beside the browse button.

Texture
The texture checkbox allows you to specify a GIF image file to use as the background of the HTML page. 
The image will be tiled to fill the entire background.    Place an X in the checkbox and click on browse to 
select the image file to use from the dialog box.    The selected image’s name and path will appear in the 
edit box next t the browse button.

Include Path To Texture Image
If this checkbox has an X in it then the path to the image file will be included in the HTML document.    
Most of the time you will not want this box to be checked.

Text Colors

Default
Sets all text colors back to their default colors.

Text Color
Changes the color of normal text.

Unchecked Link
Changes the color of unchecked links.

Checked Link
Changes the color of checked links.

Pressed Link
Changes the color of pressed links.



Image

File Name
The filename of the image that is to be inserted into the HTML document.    The path and filename can 
be entered directly into the edit box or you can click the browse button to select a file from a dialog box. 
If the path to the image file needs to be included in the document make sure the Include Path To Image 
File checkbox has an X in it.

Alignment
Specifies how the image should be aligned relevant to text on the line.

Image Size
The actual width and height of the image in pixels.    If these values are included text in the HTML 
document can be shown before the entire graphic image has been transferred.    For a GIF image press 
From File and the Width and Height will be inserted automatically.

Vspace and HSpace
Sets the vertical and horizontal spacing of text adjacent to the image.

Border
A border can be rendered around the image.    The border size is determined by this value.    A value of 
zero means no border.

Alternate Text
There are browsers that can’t view graphics on a web page, and there are users who turn the graphics 
off on browsers that do support them.    This tag allows you to enter text that will be seen in place of the 
image.



URL or Hyperlink

Link Type
The type of link that is to be made from the HTML document.    Some common link types are local, file, 
http and ftp.

Local Targets
This is a list of targets that are already defined in the current document.
* In the current version of WPC this list is reset each time you close the document.    This will be 
changed in a future version.

URL’s
A list of URL’s that are already defined in the current document.
* In the current version of WPC this list is reset each time you close the document.    This will be 
changed in a future version.

Filename
A filename can be entered directly into the edit box or click browse to select the filename from a dialog 
box.    If the path to the file needs to be included in the document make sure the Include Path To Image 
File checkbox has an X in it.



Link Anchors

Anchor Name
The name of the anchor to be created.    The anchor will be created at the current cursor position in the 
document.

Existing Anchors
A list of anchors that are already defined in the current document.
* In the current version of WPC this list is reset each time you close the document.    This will be 
changed in a future version.



Headers

Header Size or Significance
Select the type of header that is to be inserted into the document where header one is the smallest and 
header six is the largest.    If text in the document is selected then it will become the header text.

Alignment
How the header is positioned on the page.

Clear
How the header is positioned in relation to an image.

NOWRAP
Whether or not the header is to be word wrapped.



Lists

Numbered List
Unnumbered List
Definition List
Menu
Directory



Numbered List

Number Type
Selects the type of numbering that is used for the list.    The possible types are:

Numeric          (1..2..3..4..5)
Upper case alphabetic          (A..B..C..D..E)
Lower case alphabetic          (a..b..c..d..e)
Upper case roman numeral          (I..II..III..IV..V)
Lower case roman numeral          (i..ii..iii..iv..v)

Starting Number
Selects the starting number to use with the first list item.    A starting number of 3 would cause the first 
item to be numbered 3, C, c, III or iii depending on the number type.



Unnumbered List

Bullet Type
Determines the type of bullet that will be at the start of each list item.    The bullet types are:

Default
Disk
Circle
Square



A definition list is a group of terms with each term followed by an indented definition on the next line.    If 
Options, Sample Text is turned on then a sample definition list will be inserted into the document.    
Otherwise only minimal tags will be inserted.    The DT and DD tags may be copied and pasted into the 
list as many times as needed.



A menu list is a group of items, without bullets, that is usually rendered in a more compact form than an 
unnumbered list.    If Options, Sample Text is turned on then a sample menu list will be inserted into the 
document.    Otherwise only minimal tags will be inserted.    The LI tag may be copied and pasted into 
the list as many times as needed.



A directory list is a group of items which are rendered in columns, without bullets and each item is 
usually 20 characters or less.    If Options, Sample Text is turned on then a sample directory list will be 
inserted into the document.    Otherwise only minimal tags will be inserted.    The LI tag may be copied 
and pasted into the list as many times as needed.



Format

Forced Line Break Preformatted Text

Paragraph Address Block

Horizontal Tab Block Quote

Center Line Last Modified

Horizontal Rule

Forced Line Break

A forced line break gives you more control over the way the HTML document is rendered.    It causes a 
line to be broken at a specific point.

Clear
Gives you control as to how text flows around a graphic image or table.



Paragraph

Align
Specifies the horizontal alignment of the paragraph.    Possible values are:

left paragraph is on the left margin
right paragraph is on the right margin
center paragraph is centered between the margins
justify the browser will justify the paragraph when possible

Clear
Gives you control as to how text flows around a graphic image or table.

NOWRAP
Whether or not the paragraph is to be word wrapped.

Note: Paragraph attributes will stay in affect until the end of the document or another paragraph tag is 
encountered.



Horizontal Tab

The horizontal tab is used when you want control over the horizontal positioning of a line.

Indent
How far, in half point units, to the tab stop.

Align
Can be used to override any alignment attributes of the current paragraph.    Possible values for align 
are Left, Center and Right.



Center Line will cause the text between the <Center> and </Center> tags to be rendered in the center, 
between the left and right margins of the page.    Any text that is selected will automatically be inserted 
between the center tags.



Horizontal Rule

Horizontal rule inserts a line that can be used to separate sections of the page.

Size
Determines the thickness of the horizontal rule.    The default value is two.

Width In Percent
Specifies how wide the rule should be based on a percent of the page width.

Alignment
Aligns the horizontal rule with the left margin, right margin or in the center of the page.

No Shade
By default a horizontal rule is rendered three dimensionally with a shadow.    No Shade causes the rule 
to be rendered without the shadow.



Preformatted text inserts the <Pre> and </Pre> tags.    Any text between these tags will be rendered 
exactly as they appear in the HTML document when possible.



Address Block

The address block is used to enter information such as the HTML authors name and address.    This 
block is usually located at the top or bottom of the page.

Clear
Gives you control as to how text flows around a graphic image or table.

NOWRAP
Whether or not the address block is to be word wrapped.



Block Quote

A block quote is used to enter a quotation into the document.

Clear
Gives you control as to how text flows around a graphic image or table.

Include Credit
Allows the source of the quotation to be credited.

NOWRAP
Whether or not the quote is to be word wrapped.



Inserts a line in the document in the format of: Last Modified: Sunday, January 7, 1996 at 11:58 PM.    
The computers current date and time are used in the statement.



Tables

Table

Width %
The width of the table as a percentage of the width of the page.

Height %
The height of the table as a percentage of the height of the page.

Border
The thickness of the border around the table.

Cell Padding
The amount of padding that is to be done to the text within the cells.

Cell Spacing
Specifies how thick the frame around each cell is.

Table Rows and Columns

Rows
The number of rows in the table.

Columns
The number of columns in the table.

Left Align
Text will be left aligned in each cell.

Center
Text will be centered in each cell.

Right Align
Text will be right aligned in each cell.

Caption

Caption
If text is entered in this text box it will be displayed as the tables caption.

Top
The caption will appear at the top of the table.

Bottom
The caption will appear at the bottom of the table



Headings

Align
Specifies whether the headings should be left justified, right justified or centered within their cells.

VAlign
Specifies how the headings should be vertically aligned.

Columns
How many header columns are needed.

Row Span
How many rows tall the headers should be.

Column Span
How many columns wide the headers should be.



Text Formatting

Bold Underline
Italic Comment

Strong Sample
Emphasis Keyboard
Citation Variable
Code Definition

Blinking



The browser renders the text as bold.    Usually used to show emphasis.



Renders text in italics.



Provides strong typographic emphasis.    Strong text is usually rendered as bold.



Provides typographic emphasis.    Usually rendered in Italics.    Emphasis is preferred over italic unless 
the text specifically needs to be rendered in italics.



Specifies a citation.    Usually rendered in italics.



Indicates an example of code.



Causes the specified code to blink.



The specified text should be underlined.



Inserts a comment into your HTML document.    Comments are not shown by the browser.



Indicates a sequence of literal characters.



Indicates a string of characters that should be entered from the keyboard.



Indicates a variable name.



Used to define a term.



Symbols

&amp ampersand
&copy copy right
&lt less than sign
&gt greater than sign
&nbsp no-break space
&quot double quote
&AElig capital AE dipthong (ligature)
&Aacute capital A acute accent
&Acirc capital A circumflex accent
&Agrave capital A grave accent
&Aring capital A ring
&Atilde capital A tilde
&Auml capital A dieresis or umlaut mark
&Ccedil capital C cedilla
&ETH capital Eth Icelandic
&Eacute capital E acute accent
&Ecirc capital E circumflex accent
&Egrave capital E grave accent
&Euml capital E dieresis or umlaut mark
&Ntilde capital N tilde
&Oacute capital O acute accent
&Ocirc capital O circumflex accent
&Ograve capital O grave accent
&Oslash capital O slash
&Otilde capital O tilde
&Ouml capital O dieresis or umlaut mark
&THORN capital THORN Icelandic
&Uacute capital U acute accent
&Ucirc capital U circumflex accent
&Ugrave capital U grave accent
&Uuml capital U dieresis or umlaut mark
&Yacute capital Y acute accent
&aacute small a acute accent
&acirc small a circumflex accent
&aelig small a dipthong (ligature)
&agrave small a grave accent
&aring small a ring
&atilde small a tilde
&auml small a dieresis or umlaut mark
&ccedil small c cedilla
&eacute small e acute accent
&ecirc small e circumflex accent
&egrave small e grave accent
&eth small eth Icelandic
&euml small e dieresis or umlaut mark
&iacute small i acute accent



&icirc small i circumflex accent
&igrave small i grave accent
&iuml small i dieresis or umlaut mark
&ntilde small n tilde
&oacute small o acute accent
&ocirc small o circumflex accent
&ograve small o grave accent
&oslash small o slash
&otilde small o tilde
&ouml small o dieresis or umlaut mark
&thorn small thorn Icelandic
&uacute small u acute accent
&ucirc small u circumflex accent
&ugrave small u grave accent
&uuml small u dieresis or umlaut mark
&yacute small y acute accent
&yuml small y dieresis or umlaut mark

Forms

Forms are used to get information from the user.    Once the form has been filled in, it is submitted as 
designated by the FORM element.

    Clicking on the form button opens the form toolbar.

Form Body
Every form must be enclosed with FORM elements.    There can be more than one form in a document 
but forms can’t be nested.

Mail To
Specifies where to send a submitted form.

Mail Subject
The subject of the form.

Input
Opens a menu containing the different input elements.

Text - a single line of text
Text Area - multiple lines of text
Integer - an integer value
Range - an integer value within a certain range
Float - a floating point value
Check Box - an on or off checkbox
Radio Button - allows a selection from a group
Select - allows a selection from a drop down list box
Clear Button - clears the contents of all input elements on the form
Submit Button - sends the information contained in the form



Font

Font Size
Allows you to set the size of the font that will be rendered by the browser.    Font size one is the smallest 
and seven is the largest.

Color
Sets the color of the font from a dialog box.



Base

Sets the default address of the URL used to retrieve the document.

Example:

<base href=“http://www.geocities/Broadway/1172/index.html”>
<img src=“steve.gif”>

The browser would interprit the last line as:

<img src=“http://www.geocities/Broadway/1172/steve.gif”>



Frame

Frames give the web page more than one viewing window.    Each window may have different contents 
and can be scrolled independently of the other windows.

New Frame Page Frame
Frame Set No Frames
Example

Creates a new document and asks if you want to insert the default frame template.



Frame Set

Sets the number of frames (windows) that will be on the page.    The frames are referenced as rows and 
columns.    Frame Sets may be nested.



Frame

Source
What is to appear in the frame. (file, URL, Image, etc...)

Include Path
If you use browse to select a file or image check this box if you want to include the path with the name.

Name
A unique name for this frame.

Margins
Sets the margins inside the frame

Scrolling
Yes - Vertical an horizontal scroll bars are shown whether they are needed or not.
No - Scroll bars are not shown. The contents of the frame can not be scrolled.
Auto - If the contents are too large for the frame scroll bars will be visible.

No Resize
The frame can not be resized.



Frames are only visible when certain browsers are being used.    No Frames allows you to insert text that 
will be seen when a viewer doesn’t have Frame capabilities.



Frame Example

<HTML>
<HEAD><TITLE>WPC Commands Available</Title></HEAD>

<FRAMESET COLS="100%" ROWS="22%,60%,*">
          <FRAME SRC="topframe.htm" NAME="topframe" SCROLLING="no" NORESIZE>
          <FRAMESET COLS="50%,*" ROWS="100%">
          <FRAME SRC="wpc_cmd1.htm" NAME="leftframe" SCROLLING="auto" NORESIZE>
          <FRAME SRC="wpc_cmd2.htm" NAME="rightframe" SCROLLING="auto" NORESIZE>
          </FRAMESET>
          <FRAME SRC="botframe.htm" NAME="bottomframe" SCROLLING="no" NORESIZE>

</FRAMESET>

<NOFRAMES>

<BODY BGCOLOR=#008080 VLINK=#FF00FF ALINK=#FF0000>
<P align=center>
<FONT SIZE=6 COLOR=0000FF><B><I>Sorry You Can’t See The Frames</I></B></FONT>
<BR><BR>
<A HREF="index.html">Return To Steve's Home Page</A>

</BODY>

</NOFRAMES>

</HTML>



Browser

Browser on the menu bar allows you to view your web page as you are working on it.    However the 
browser is not internal to WPC.    An external browser is loaded and the current page you are working on 
is displayed as it would be seen on the net.

The first time you click on Browser you will be asked for the location and name of the browser you wish 
to use.    If you need to change your browser or it’s location click on Options/Browser from the main 
menu.

WPC now uses DDE to cummunicate with NetScape.    This makes the viewing of your pages very quick. 
Each time you are finished viewing the document, minimize NetScape (do not exit), and the next time 
you click on browser your page will be visible within a couple of seconds.    Please note that the first time 
you click on browser in a session NetScape does have to load, so it will take a few moments.

Please not that WPC has not been tested with every browser that is being used on the net.    If you find a 
browser that will not work please let us know.



View

Form Toolbar
Toggles the toolbar that is used to create forms on and off.    This toolbar may only be visible when a 
document is open.

User Toolbar
Toggles the user defined toolbar on and off.    This toolbar contains up to twenty key sequences that you 
have defined.    To edit this toolbar click on Options/Define Toolbar/Edit.



Arranges the document windows by either cascading or tiling them.    Tile allows you to view sections of 
more that one document at a time which works well for copying and pasting text.



Options

Define Toolbar

Browser

Example Text

Create Backup File

Wordwrap

Font

Register



Browser

If you change the name of, or the path to, your browser this is where you can change it.    The top edit 
box, labeled Current, and shows the current browser setup.    The bottom edit box, labeled New, is 
where you can enter the new setup information.    You can also browse to find the new browser’s 
location.    Browser Type tells WPC what type of browser to open.



Define Toolbar

Edit

Load



Edit Toolbar

The user defined toolbar may contain up to twenty segments of code that you use most often.    To edit a 
button on the toolbar click on it’s corresponding EDIT button.    The title will appear when you drag the 
mouse over the button.    You can enter up to 2K of code for the button.    The buttons do not have to be 
defined in any certain order.    To delete a button from the toolbar simply delete it’s title and text.

You can have as many key files as you want and the next time you start WPC the previously used key 
file will automatically be loaded.



This option toggles word wrap on and off.    This is important when you are importing a text file as 
preformatted text.



Allows you to change the type, size and color of the font being used in the edit windows.



By defauld WPC will create a backup of the file you are working on.    This option can be toggled on and 
off.



Allows you to load in a previously saved key file.    Once the file is loaded the buttons can be accessed 
on the user toolbar.    When you exit WPC the last file that was loaded will be saved as the default 
toolbar so the buttons will still be there the next time WPC is started.



By default WPC inserts example text each time a tag is added from the menus or toolbar.    Example 
Text under options toggles this feature on and off.    A check mark beside Example Text means that the 
feature is on.



Register

If you have been using WPC for more than 30 days you should have registered it.    Upon receiving your 
registration fee I will send you a registration certificate with the information you need to enter here.



About



Starts this help document.



Import

Import under the File menu allows you to take text from any ascii file and put it directly into your HTML 
document.    You can also tell WPC how to insert the text and what conversions, if any, to perform on the 
text before it is inserted.

Import as preformatted text
When this option is checked the entire block of text is imported as a block of preformatted text.    

In other words it will look the same as it did in the text file, depending of course on how long the lines of 
imported text are.

Break at end of each line
When this line is selected a <BR> will be appended to each line.    This option is unavailable when 

Import as preformatted text is selected.

Break on blank lines
This will cause a <BR> to be inserted on lines that contain no text as in a paragraph break. This 

option is also unavailable when Import as preformatted text is selected.

Conversions
Up to nine conversions can be configured that will be performed on the imported text.    A good 

example would be to convert the string ----- to <HR>.    The edit boxes on the left side are the strings you 
want to convert and the boxes on the right are what you want to convert to.    The text you enter in the 
conversion boxes is saved each time you make an entry.    If you have entered a conversion you don’t 
want to make then do not put a check beside it.    Only the conversions that have checks beside them 
will be performed.



Miscellaneous

Opening a file at startup
You can pass a file name to WPC and the file will be opened at startup.    This means that if you want to 
associate the HTM file type with WPC you can click on a file and WPC will automatically run and open 
the file you clicked on.



Working With Projects

WPC makes creating a page for the web even easier with the use of projects.    If the page has several 
files associated with it, they can all be grouped into a project.    When the project is loaded all of it’s files 
will be opened.    Here are a few things to remember when working with projects in WPC.

Adding & Removing Files from a project
When a project is saved any open files will be saved in the project.    If you need to add a file to the 
project, open the file or create a new file.    To remove a file from a project close the file before saving the 
project.    Closing a file doesn’t delete the file it simply removes the file from the project.

Closing a project
There are two ways to close a project.    The first is to click Close Project on the File menu.    The other 
way is to close all of the files in the project.    When the last file is closed the project will also be closed.

Using The Browser
When you have an open project and click on the Browser only the currently selected file is sent to the 
browser and not the entire project.




